Introduction to ILWIS 3.11 using a data set from Kathmandu valley.

C.J. van Westen
Dept. of Environmental System Analysis,
International Institute Geo-Information Science and Earth Observation (ITC),
P.O. Box 6, 7500 AA Enschede, The Netherlands.
Tel: +31 (0)53 4874263, Fax: +31 (0)53 4874336; e-mail: westen@itc.nl

The data set for this exercise was provided by ICIMOD.

Summary & background
The exercises in this chapter are modified from the ILWIS Users Guide, by substituting the original data with data from Kathmandu valley.
These exercises are intended to bring all participants to a common level, and allow them to have a basic understanding of the functionalities of ILWIS 3.11.

Available data for the exercise

<table>
<thead>
<tr>
<th>File name</th>
<th>File contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Satellite image</td>
<td></td>
</tr>
<tr>
<td>Avn1geo</td>
<td>Band 1 Spot image (georeferenced, image domain)</td>
</tr>
<tr>
<td>Topographical maps</td>
<td></td>
</tr>
<tr>
<td>Contours Kathmandu</td>
<td>Contour lines Kathmandu valley (value domain)</td>
</tr>
<tr>
<td>Point, segment and polygon maps</td>
<td></td>
</tr>
<tr>
<td>Area-type</td>
<td>Administrative units (polygons with ID domain)</td>
</tr>
<tr>
<td>Geological units</td>
<td>Geological units (polygons with class domain)</td>
</tr>
<tr>
<td>Borehole_1</td>
<td>Boreholes (point map with ID domain)</td>
</tr>
<tr>
<td>Drainage</td>
<td>Drainage network (segment map with class domain)</td>
</tr>
<tr>
<td>Roadtype</td>
<td>Road network (segment map with class domain)</td>
</tr>
</tbody>
</table>
Introduction to ILWIS 3.1
Using data from Kathmandu valley, Nepal

ILWIS is an acronym for the Integrated Land and Water Information System. It is a Geographic Information System (GIS) with Image Processing capabilities. ILWIS has been developed by the International Institute for Geo-Information Science and Earth Observation (ITC), Enschede, The Netherlands.

As a GIS package, ILWIS allows you to input, manage, analyze and present geographical data. From the data you can generate information on the spatial and temporal patterns and processes on the earth surface.

Geographic Information Systems are nowadays indispensable in many different fields of applications to assist in the decision making process. Most decisions are influenced by some facts of geography. What is at a certain location? Where are the most suitable sites? Where, when and which changes took place? Here are some examples.

- In land use planning, GIS is used to evaluate the consequences of different scenarios in the development of a region.
- In geology, GIS is used to find the most suitable places for mining, or to determine areas subject to natural hazards.
- Areas that may be affected by pollution are analyzed using GIS functions.
- Extensions of cities are planned, based on analysis of many spatial and temporal patterns, etc.

In order to be able to make the right decisions, access to different sorts of information is required. The data should be maintained and updated and should be used in the analysis to obtain useful information. In this process ILWIS can be an important tool.

This Lesson is intended to introduce you to ILWIS, and specifically to the user interface. You will learn how to start ILWIS, the functions of the Main window and how to open maps and tables, using spatial and attribute data from Kathmandu, Nepal.
1.1 Starting ILWIS

To start ILWIS, double-click the ILWIS icon on the desktop. After the opening screen you see the ILWIS Main window (see Figure 1.1). From this window you can manage your data and start all operations.

![Figure 1.1: The ILWIS Main window](image)

The ILWIS Main window consists (by default) of a Title bar, a Menu bar, a Standard toolbar, an Object selection toolbar, a Command line, a Catalog, a Status bar and an Operations/Navigator pane with an Operation-tree, an Operation-list and a Navigator.

There is a possibility that the right-central part (i.e. the Catalog) of the Main window on your screen does not look exactly the same as shown in Figure 1.1. This may be due to the fact that you have another system configuration and/or that during the installation of ILWIS you decided to copy the data files to a different directory than the standard start-up directory C:\ILWIS3\Data\Example Data.

1.1.1 The Navigator

Before continuing with the exercises you first need to change to the subdirectory ILWIS Intro Kathmandu, where the data files for this chapter are stored.

You can use the Navigator (Figure 1.2) to change the current drive and working directory.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

Figure 1.2: The ILWIS Navigator.

- Click the word Navigator in the Operations/Navigator pane.

The Navigator lists all drives and directories (i.e. folders) in a tree structure. The Navigator also has a History to easily return to previously visited drives and directories.

- Click on the drives and folders in the Navigator until you are in the directory where the data for this exercise has been stored. The data is located in the directory ILWIS Intro Kathmandu.

1.1.2 Catalog(s)

If you are in the correct directory ILWIS Intro Kathmandu you will see, that the right hand side of the Main window, looks the same as Figure 1.3. This part of the Main window, in which maps, tables and other ILWIS objects in the working directory are displayed each with its own type of icon, is called the Catalog. When you double-click an object in the Catalog, it will be displayed.
Among others, the following objects can be seen, of which most of them are related to the city of Kathmandu:

- **Kathmandu**
  A coordinate system, containing the definition of the coordinate system (the minimum and maximum coordinates of the study area and the optionally map projection) used for the maps of the Kathmandu area;

- **Geological units**
  A domain, listing names of the geological units;

- **Geological units**
  A polygon map containing information on geological units;

- **Geological units**
  A representation, containing the color assignments of the mapping units in the geological map;

- **Area-type**
  An attribute table containing information on the administrative units in the city (Wards);

- **avnlgeo**
  A raster map, containing a band of a satellite image.

For a complete list of ILWIS objects and their icons, see the summary of section 1.1 or the ILWIS Help topic Basic concepts, ILWIS objects and icons.

### Customizing the Catalog

To show only maps and tables in the Catalog:

- Click the Customize Catalog button in the Standard toolbar (Figures 1.1 and 1.8) of the Main window. The Customize Catalog sheet is opened.

The object Selection tab contains a list box in which the object types that are shown in the Catalog appear highlighted. You see that all ILWIS objects are selected. To show only the map and table objects, i.e. the objects with the icons and 

- Select on the object Selection tab the first object type (i.e. the Raster map), keep the left mouse button pressed and move the mouse pointer to the last object you want to select (i.e. the Table).
- Release the mouse button and click OK.

You will see that the Catalog has changed and that now only the map and table objects are shown in the current Catalog. The ILWIS Main window may show more than one Catalog. You can thus keep your data organized in different directories.
You can open another Catalog by clicking the New Catalog button in the Standard toolbar and selecting a new directory. You can also select the New Catalog command on the Window menu of the Main window.

Position the mouse pointer on an object, for example on polygon map Administration. A description of this map will appear on the Status bar (Figure 1.7) of the Main window.

1.1.3 Title bar and Menu bar

The Title bar (Figure 1.4) shows the name of the currently active Catalog. You can move a window to another position on the screen by dragging that window’s Title bar to another position.

The Menu bar (Figure 1.5) can be used for example to start an operation. The ILWIS Main window has six menus: File, Edit, Operations, View, Window and Help.

- Click Operations in the Menu bar. The Operations menu is opened. The menu contains commands for all ILWIS operations, which are grouped. The triangles to the right of the commands on a menu indicate that there is another cascading menu.
- Position the mouse pointer on the command Image Processing. A submenu appears.
- Select the Filter command. The Filtering dialog box is opened. In this dialog box you can select among other things the input maps for an operation.
- Close the dialog box by clicking the Cancel button.
- Open some more menus and have a look at their contents. The Status bar (at the bottom of the Main window) gives short explanations.

1.1.4 The Operation-tree and Operation-list

Let us now concentrate on another part of the ILWIS Main window. The Operation-tree and the Operation-list (Figure 1.6) are located on the first two tabs in the Operations/Navigator pane, by default along the left-hand side of the Main window.

- The Operation-tree provides a tree structure for all ILWIS operations, similar to the Operations menu.
- The Operation-list contains an alphabetic list of all ILWIS operations.

In the Operation-tree as well as in the Operation-list each item is preceded by an icon. The icon indicates the output data type of the operation. By double-clicking an operation, the operation will be started. We will do this later.
In the Operation-tree, double-click Image Processing, or click on the + in front of the Image Processing icon to expand the Image Processing tree.

Position the mouse pointer on one of the operations, for example on the Filter operation.

### 1.1.5 Status bar

When the mouse pointer is positioned on an operation, the Status bar (Figure 1.7), located at the bottom of the Main window, shows a short description of that operation.

To get more information on an operation:

- Click in the Operation-list with the right mouse button on an operation and select Help from the context-sensitive menu. An Additional Help window appears with a short explanation of the operation.

- You can close the Additional Help window again by pressing the Close button in the Title bar of the Help window or by double-clicking the control-menu icon.

The Status bar also gives short information when you move the mouse pointer to a menu command, to a button in the Toolbar or to an object in the Catalog.

- Click in the Catalog with the right mouse button on polygon map Administration to get a context-sensitive menu.

A Context-sensitive menu is a menu, which gives only those menu commands that are applicable to the moment you use the right mouse button; thus you will get a different menu depending on where and when you use the right-mouse button. For example, if you use the right mouse button on a polygon map, the context-sensitive menu will only show the
operations, which can be applied on polygon maps. Context-sensitive menus are shortcuts for normal menu commands

1.1.6 Toolbars of the Main window

You will go back to the Main window to see three more items. Below the menu, you find two toolbars:
- The Standard toolbar
- The Object selection toolbar

The Standard toolbar

The *Standard toolbar* (Figure 1.8) provides shortcuts for some regularly used menu commands.

![Figure 1.8: Standard toolbar of the ILWIS Main window.](image)

The *Standard toolbar* has the following buttons:

- **New Catalog**
- **Open Map**
- **Open Pixel Information**
- **Copy**
- **Paste**
- **Delete**
- **Properties**
- **Customize Catalog**
- **List**
- **Details**
- **cd..**

When you leave the mouse pointer for a short period of time on top of a button a *ToolTip* will appear with the name of the button/menu command that it will perform. Also the *Status bar* gives some information on the working of the button. So far, you have used the *Customize Catalog* button.

Other buttons that you will probably use frequently are:

- **List**. Show the objects in the current *Catalog* as a list of icons and object names.
- **Details**. Show the details of the objects in the current Catalog in a table-like form

The Object selection toolbar

The *Object selection toolbar* (Figure 1.9) allows you to specify the object types that you wish to see in the current *Catalog*.

![Figure 1.9: The Object selection toolbar.](image)

Only the object types of which the button appears down will be shown. For a list of all ILWIS object types and icons, see the summary of section 1.1. The first button, the ILWIS button is used to hide all objects (after which you can click specific object buttons, to show only these
object types), or to show all object types. To add coordinate system Kathmandu to the Catalog:

- Press the Coordinate Systems button in the Object selection toolbar. Coordinate system Kathmandu is now added to the Catalog.

To hide the coordinate system again:

- Click the Coordinate Systems button again.

1.1.7 The Command line

The last item we will discuss now is the Command line (Figure 1.10).

Figure 1.10: The ILWIS Command line.

You can use the Command line to type MapCalc formulas when you want to calculate with raster maps, but also other operations can be performed by typing an expression on the Command line.

The Command line has a History. You can use:
- the Arrow Up key of your keyboard to retrieve previously used expressions and commands;
- the Arrow Down key to scroll forwards again, and
- the Arrow Down button at the right hand side of the Command line to open a list of previously used commands and expressions.

1.1.8 Getting help

- Open the Help menu.

The ILWIS Help allows you to obtain information from any point within the program. The Help menu differs per window. In the Main window the Help menu has many options; we will explain a few of them now:

- Help on this Window. You obtain help on the current window. Depending on the window from which you select this help option, you can get help on the Main window, the map window, the table window, the pixel information window, etc.

- Related Topics. When this menu option is selected a dialog box appears with a list of topics that are related to the current window.

- Contents. Displays the Help Contents. By clicking the links in the table of contents you can go to any help topic you like.

- Index. The Index page of the ILWIS Help is displayed. Type a keyword or click any keyword in the list on which you wish to get help.

- Search. The ILWIS Help viewer is opened with the Search tab selected. Type some characters of the keyword or phrase on which you want to obtain help and press Enter.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

or click the List Topics button to get a list of topics. In the Select topic list box select the topic you want to display and click the Display button or press Enter .

- Basic Concepts. Gives an overview of the basic concepts of ILWIS. These concepts will be treated in chapter 2 of the User’s Guide.

- Select from the Help menu the command Help on this Window. The ILWIS Help viewer (Figure 1.11) is opened and the help topic Main Window, Contents is shown.
- Click the hyperlink Introduction. The ILWIS Help viewer refreshes and displays the topic Main window: Introduction, in which all parts of the Main window are explained.
- Click any of the links. Another topic appears explaining you more.

![Figure 1.11: The ILWIS HTML Help viewer.](image)

The ILWIS HTML Help viewer (Figure 1.11) has three parts:
- a Topic pane that shows the topic the user has selected;
- a Navigation pane with 4 tabs: a Contents tab, an Index tab, a full-text Search tab, and a Favorite tab;
- a Toolbar which allows users to Show or Hide the Navigation pane, to move Forward to the next topic or Back to the previous topic, to go to the Home/Contents Page topic, and to adapt the Font size, to Print topics and to change the Options.

To find a Help topic, click one of the following tabs in the help window:
- To browse through topics by category, click the Contents tab.
- To see a list of index entries, click the Index tab and then either type a word or scroll through the list.
- To search for words or phrases that may be contained in a help topic, click the Search tab.

In the left of the Help window, click the topic, index entry, or phrase to display the corresponding topic in the Topic pane.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

Summary: the Main window of ILWIS

When you start ILWIS, the first thing you will see after the opening screen is the ILWIS Main window. From this window you can manage your data, start all operations and select all data. The Main window contains the following items:

- A Catalog lists the available maps, tables and other ILWIS objects in the current working directory. When you double-click an object, the object will be opened. When you click an object with the right mouse button, you can choose to start an application with the selected object as input. The ILWIS Main window can show one or more Catalog(s).

- The ILWIS object types and their icons that can be shown in a Catalog are:
  - raster maps
  - polygon maps
  - segment maps
  - point maps
  - tables
  - map lists
  - object collections
  - map views
  - layouts
  - annotation text objects
  - domains
  - representations
  - georeferences
  - coordinates systems
  - histograms of raster maps
  - histograms of polygon maps
  - histograms of segment maps
  - histograms of point maps
  - sample sets
  - two-dimensional tables
  - matrices
  - (user-defined) filters
  - user-defined functions
  - scripts

- The Operation-tree provides a tree structure for all ILWIS operations, similar to the Operations menu.

- The Operation-list contains an alphabetic list of all ILWIS operations. Each operation is preceded by an icon; the icon indicates the output data type of the operation.

- The Navigator provides a tree structure for all drives and directories and has a history of recently visited drives and directories.

- The Title bar is always located at the top of the window. It shows the name of the window and can be used to move the window on the screen.

- The Menu bar can be used to start an operation, to create or edit objects, to view the properties of an object, etc.

- The Standard toolbar provides shortcuts for regularly used menu commands such as Customize Catalog, List/Details View, etc.

- The Object selection toolbar can be used to select the object types that should be visible in the currently active Catalog.

- The Command line is mainly used to type calculations (MapCalc) and expressions (i.e. perform operations).
The Status bar gives short information on the item on which the mouse pointer is located: a menu command, a button in the Toolbar, an object in the Catalog, an operation in the Operation-list or the Operation-tree, etc.

The ILWIS Help allows you to obtain help information from any point within the program. The ILWIS Help viewer has a Topic pane, a Navigation pane and a Toolbar.

### 1.2 Displaying geographic data

Geographic data are organized in a geographic database. This database can be considered as a collection of spatially referenced data that acts as a model of reality. There are two important components of geographic data (Figure 1.2.1): the geographic position and the attributes, entities or properties. In other words, spatial data (where is it?) and attribute data (what is it?) are distinguished. In the example of Figure 1.2.1, you can see that we have a (very simplified) map on one side and a table on the other.

Maps are considered spatial data, since the information they contain is directly related to certain locations on the earth’s surface. The location of the units A, F and G are specified with respect to their X and Y coordinates.

Tables, on the other hand, do not contain direct information on a location. They contain descriptive information (in this case the names of the land use types and the value of the land in monetary units). If we would only have the table, the data would not be useful, since we don’t know where the units are located. If we would only have the map, we still don’t know anything about the units. In a Geographic Information System (GIS) like ILWIS, the link between spatial and attribute data is the key to get real information. Only by combining spatial and attribute data we can get answers to questions such as: Where are the land use units with a value more than 250?

**Spatial data: where is it?**  **Attribute data: what is it?**

<table>
<thead>
<tr>
<th>Landuse</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Agricultural</td>
<td>500</td>
</tr>
<tr>
<td>F Forest</td>
<td>300</td>
</tr>
<tr>
<td>G Grassland</td>
<td>200</td>
</tr>
</tbody>
</table>

**Figure 1.2.1: Spatial and non-spatial data in ILWIS.**

In the following pages we will show you how to display spatial data and attribute data in ILWIS. We will introduce you to the map window and you will practice displaying a map. The map to be displayed is the polygon map Administration that shows the different administrative units (‘desa’) in Kathmandu, Nepal. This map was digitized from a paper map. A polygon map is a vector data object containing closed areas including the boundaries making up the areas, which in this case represent the administrative units.

### ILWIS dialog boxes

- Press the polygon map button in the Object selection toolbar to show the polygon maps again and double-click the polygon map Area_type in the Catalog. The Display Options - Polygon Map dialog box appears (see Figure 1.2.3).
A dialog box allows the user to enter the information required by ILWIS to carry out an operation. Dialog boxes differ depending on the application you are performing. The dialog box, which is displayed now, is used to specify how you want to display a polygon map. In general, an ILWIS dialog box can have features such as:

**Title bar.** Shows the name of the dialog box and can be used to move the dialog box on the screen. In this case the title is: **Display Options - Polygon Map.**

**Text box.** A small box, which can be used for typing text or values. The dialog box shown on your screen contains a Text box in which you can specify the Boundary Width of the land use units lines.

**Drop-down list box.** A small box with an Arrow Down button which allows you to select items. A list, including the available data, will be displayed when the arrow button or list box is clicked. The button on the right hand side is the create button. The Create button can be used to create an object when the list excludes a proper object. When you click the Create button, the program proceeds to a new dialog box. The dialog box in Figure 1.13 contains two list boxes: one in which you can specify the color of the boundary lines of the land use units (Boundary Color), and another (Representation) in which you can indicate the color of the units themselves. These colors are stored in an object called representation (see section 2.4).

**Check box.** This is a small square in the dialog box, which allows you to select or clear an option. The Display Options – Polygon Map dialog box has five check boxes. When you select the Info check box, you will be able to read information about the meaning of the land use units, once the map is displayed. The second box Scale Limits allows you to define the scale limits of the map. The third check box Mask allows you to selectively display some land use types. If the fourth box, Boundaries Only is selected, only the boundaries of the land use units will be shown. Finally, the fifth box, Attribute, can be selected if you want to display an attribute value from a table connected to the map, instead of the land use units themselves.
Command buttons are used to initiate an action. The OK, Cancel, and Help are common command buttons.

OK button: whenever you click the OK button (or press Enter on the keyboard) the dialog box is closed and the action will be executed.

Cancel button: when you click the Cancel button (or press Esc on the keyboard) the dialog box is closed and the action is canceled.

Help button: when you click the Help button (or press F1 on the keyboard) context-sensitive help information will be displayed. Context-sensitive help means help dealing with the specific dialog box.

Option buttons. Option buttons can be seen as circles and represent a group of mutually exclusive options. The selected option button contains a black dot. You can select one option at a time. Selecting another Option button, clears the other. As you can see, ILWIS gives suggestions for options in the dialog box, which are called the defaults.

To select a check box or an Option button click the check box or press the Spacebar. If the name of the option or check box has an underlined letter, you can select the Option button or check box by pressing and holding down the Alt-key while typing the underlined letter.

F

- Select the check box Boundaries Only. Now you will see that the contents of the whole dialog box changes. If you only want to show the boundary lines of the units, no input is needed anymore on how you want to display the units themselves. The content of the dialog box depends on the input of the user. That is why we call it context-sensitive.
- Select the drop-down list box Boundary Color. You will see a list with all different types of colors that you can select.
- Practice some more with the different options in the dialog box. After that, change all options again so that they are the same as in Figure 1.13. Then confirm your input by clicking the OK button or by pressing Enter.

You can move through the various options within a dialog box by using the Tab-key or the Shift+Tab-keys on the keyboard.

A map window

The polygon map Area_type is displayed in a map window (see Figure 1.2.4). All maps in ILWIS are displayed in a map window. The map window has many similar features as the Main window of ILWIS, which we have seen before. It consists by default of a:

Title bar: located at the top of the map window. The Title bar shows the name of the window and can be used to move the map window.

Menu bar: located just below the Title bar. A map window has 5 menus: File, Edit, Layers, Options and Help.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

Toolbar: located just below the Menu bar. The Toolbar provides shortcuts for some regularly used Menu commands. The Toolbar of the map window has the following buttons:

- Entire Map
- Redraw
- Measure Distance
- Pan
- Zoom In
- Zoom Out
- Normal
- Add Layer
- Remove Layer
- Save View

Scale box: Text box in which you can type the scale on which the map(s) should be displayed.

Layer Management pane: The left central part of the map window displays the layers (maps) that are added to the map window and the legend of each map. In the Layer Management pane, you can for instance change the order of the layers that are displayed. The Layer Management pane will be extensively treated in the next chapter.

Map viewer: The right central part of the map window where the maps are displayed.

Status bar: located at the bottom of the window. The Status bar displays coordinates in meters and/or geographic coordinates.

The map window can be moved, like all windows, by activating it and dragging it to another position. The size of the map window can be changed in several ways.

- Move with the mouse pointer to a border or to a corner of the map window. The mouse pointer changes into a two-headed arrow.
Drag (press the left mouse button and hold it down) the border or corner until the window has the size you want and release the left mouse button. The map window has been resized.

Maximize the map window by clicking the Maximize button in the upper right corner of the window.

When you want to study details of the map, the zooming possibility can be used.

- Click the Zoom In button in the Toolbar to zoom in on a selected area.
- Move the cursor (now in the shape of a magnifying glass) to the first corner of the area that has to be displayed in detail and click on the left mouse button. Keep the mouse button down and drag the cursor a little bit to the second corner of the area of interest; then release the mouse button. Now the selected area will appear enlarged. You can also click in the map window to zoom in.
- To roam through the map on which you zoomed in, use the Pan button or use the Left/Right/Up/Down scroll boxes in the horizontal or the vertical scroll bar.
- A fast scroll can also be achieved by dragging the scroll boxes in the scroll bars Left/Right or Up/Down, or by clicking in the scroll bar itself.
- Select the Zoom Out button in the Toolbar and click (repeatedly) in the map to zoom out.
- Click the Entire Map button to show the entire map in the map window again.

Another way to zoom in or out is by re-scaling the map.

- Activate the Scale box which is by default located next to the Toolbar of the map window and type another scale factor for the map (e.g., 1:50,000) and press Enter.

Next, we will pay attention to another part of the map window: the Status bar, which can be found at the bottom of the map window. If you move with the mouse pointer over the map, you will see that the Status bar displays the position of the mouse pointer in the map. To specify the position in an absolute way a coordinate system is used. There are many different coordinate systems in use around the world.

Coordinates can be displayed in two ways:
- as metric coordinates (X,Y), or as
- geographic coordinates (latitude, longitude).

The Status bar displays the coordinates in meters and/or geographic coordinates. First, the X, Y values of metric coordinates are given; these are followed by the degrees, minutes and seconds of the latitude and longitude (i.e., geographic coordinates).
With the Measure Distance button it is easy to measure the distances and the angle between two points.

- Click the Measure Distance button in the Toolbar of the map window, or choose the Measure Distance command from the Options menu.
- Locate the mouse pointer somewhere in the map, and press the left mouse button. Move to another point, while keeping the left mouse button pressed. When you release the mouse button a message box appears.

The Distance message box will state:
From: the XY-coordinate of the point where you started measuring;
To: the XY-coordinate of the point where you ended measuring;
Distance on map: the distance in meters between starting point and end point calculated in a plane;
Azimuth on map: the angle in degrees between starting point and end point related to the grid north;

- Click OK in the Distance box and click the Normal button in the Toolbar to go back to the normal view.

The contents of the map: domain
You can obtain information on the map contents simply by pressing the left mouse button on any of the colored units in the map.

- Press the left mouse button on different units in the map to find out what they represent.
- Find the land use class around the location: X=630183 and Y=3064699.

Domain
As you can see, the units of the Area-type are described by Identifiers, one for each administrative unit. The list of all names that can occur in a map is called in ILWIS a domain. A domain defines the possible contents of a map, a table, or a column. In other words, what do the items in a map, table or column mean? Are they classes (such as land use classes), or values or something else? The domain concept is very essential in ILWIS. The full list of class names of the administrative units can be seen in the Layer Management pane of the map window when the map is displayed, but you can also open the domain of the polygon map yourself.

- Make the ILWIS Main window active. If the Main window is visible on the screen, then you can just click any part of the Main window. If
the Main window is not visible anymore, click the ILWIS button on the Windows Taskbar at the bottom of your screen.

- Make all the objects visible by clicking the ILWIS button in the Object selection toolbar.
- Double-click the domain Geological units in the Catalog of the Main window.

The Domain Class editor is opened. As you can see, the domain lists all possible class names of the map. It is simply a list of all administrative units, which can occur in the map. Since these are different classes, we speak of a class domain.

- Close the Domain Class editor by clicking the Control-menu icon and select Close.

We started this lesson by explaining the difference between spatial and non-spatial (or attribute) data. From the map window, we can also obtain information on attributes, related to the different administrative units of the map, which is displayed.

- In the map window, double-click with the left mouse button a unit in the polygon map Area-type.

Now you will see a small window appearing with the title Attributes. Inside the window you will see 8 lines. With information on district name, ward name, area, population, number of houses etc.

Let us look now in more detail to tables, but first close the map window.

- Close the map window by opening the File menu in the map window and choose Exit, or click the Close button in the map window.

A table window

Table

We will finish this chapter by showing you how to display attribute data.

- In the Catalog, double-click the table Area_type.

The table Area_type is now displayed in a table window (Figure 1.2.5). As you can see from Figure 1.2.5, a table window contains many of the features we have already seen in the Main window and in the map window. It has a Title bar, a Menu bar with the menu options: File, Edit, Columns, Records, Graphs, View and Help and a Toolbar with the buttons:

- Copy
- Paste
- New Graph Window
- Goto First Record
Furthermore, there is a **Command line**, a **Table viewer**, a **Split bar** with the **Statistics Pane** below it and a **Status bar**.

The table contains 8 columns. The left column, in gray color, has no header. If you look to the numbers in this left column you will remember that those are the same that you have seen in the map **Area-type**. This is again the domain; a domain can thus define the contents of a map, but also the contents of a table.

Next to the left gray column containing the domain items, the table has more columns, one of them is called **District**. This column is an attribute column that contains the district of the administrative units. As you can see, this column contains classes. Further next to this column you see the column **Area_km2**.

- Double-click the Column header with the name **Population** on it. The **Column Properties** dialog box (Figure 1.16) appears.
Figure 1.16: Example of a Column Properties dialog box.

This dialog box contains information on column Population. The dialog box shows for instance the domain of column Population: Default Value Domain. The next line gives the Value Range of column Population: between 0 and 100000 The actual values in the column are also shown: Minimum: 23 Maximum: 28967

- Click the Cancel button to close the Column Properties dialog box.

Information on the Minimum (Min) and Maximum (Max) values in the column, together with the Average (Avg), Standard Deviation (StD) and Sum of the column, is visible in the Statistics Pane in the lower part of table Area-type

By clicking the Column option in the dialog box, you can select the column which you wish to sort. The record order of the table will change as well.

**Summary: displaying maps and tables**

In this section you have learned:

- How to use dialog boxes: How to enter parameters to define the way in which a map is displayed.

- The basics of a map window: How to open a map; the different components of a map window: Title bar, Menu bar, Toolbar, Map viewer, Layer Management Pane, Status bar; to resize a map window; to zoom in and to zoom out; to read the coordinates of a map (coordinate system); to know the contents of a map (domain).

- The basics of a table window: How to open a table; the different components of a table window: Title bar, Menu bar, Toolbar, Command line, Table viewer, Split bar, Statistics Pane, Status bar; the fact that contents of a table are defined by the domain of the table; the fact that columns also have a domain. The display of an entire table (i.e. Table View), or only the contents of a certain record (i.e. Record View); to sort a table.
2.1 Structure of spatial data in ILWIS

In the previous chapter we have looked at how you can display maps and tables in ILWIS. Now we will go more in depth about the way the data are structured. We will first pay attention to spatial data.

Spatial features are represented in ILWIS in the following ways:
- **Points.** Many items can be represented as single points on a map. Points may refer to rainfall stations, houses, sampling points for field observations, etc.
- **Lines.** Linear features such as roads, drainage lines or contour lines.
- **Areas.** Features which occupy a certain area, such as a land use unit (forest), a geological unit etc.

The spatial entities described above can be represented in digital form in two data models (figure 2.1): vector, or raster models. Both models store details on the location of entities and their value, class name or identifier. The main difference between the two data models is the way they store and represent the locations.

![Figure 2.1: Vector and raster representation of points, lines and areas](image)

**Vector model**

In a vector model the position of each spatial feature is defined by (a series of) X and Y coordinates. Besides the location, the meaning of the feature is given by a ‘code’.

- **Points**
  The location of a point is described by a single x-y coordinate pair. Points are stored in point maps by registering their location in X and Y coordinates and by coding them (e.g. a rainfall station, elevation).

- **Segments**
  A line is stored as a series of X and Y coordinates (points) that best reflect its characteristics. The points are connected by straight lines. In ILWIS the line features are called segments. A segment is described by the coordinates of its starting and ending points (its nodes) and the intermediate points. The code of a segment describes what the segment represents (e.g. road, state boundary, contour value).

- **Polygons**
  Areas are represented by their borders or boundary lines, which are in fact segments, with the difference that all segments are enclosing areas. Such an area defined by its boundary line and
by its code is called a \textit{polygon}. The code represents the contents of the polygon (e.g. forest, city, sandstone, etc.).

\textit{Vector maps} in ILWIS are either \textit{point}, \textit{segment}, or \textit{polygon maps}. Most of these are obtained by digitizing. Vector maps require less disk storage space and are suitable for creating high quality outputs. They are less suitable for a number of GIS operations, especially those dealing with map overlaying. You can rasterize the vector maps (this will be explained in chapter 4) into raster maps. In ILWIS, most of the analysis operations are raster-based.

**Raster model**

In a raster model, spatial data are organized in \textit{grid cells} or \textit{pixels}, a term derived from \textit{picture element}. Pixels are the basic units for which information is explicitly recorded. Each pixel is only assigned one value. The maps stored in ILWIS according to the raster model are called \textit{raster maps}. Pixels in a raster map all have the same dimensions. Thus, it is unnecessary to store all their coordinates as the pixels are arranged in a regular pattern. It is enough to determine the pixel size and the parameters to transform between \(X\) and \(Y\) coordinates of a map and the pixel locations in the raster map (rows/lines and columns). The process to establish this relationship is called \textit{georeferencing}. Through a georeference you calculate the parameters used in the equations to transform between a coordinate system and pixel locations in the image.

A \textit{point} is described in the raster model by the position of a single pixel. The position of each cell is defined by a row and column number. A pixel is assigned one code (label). A \textit{line} and an \textit{area} are described by a set of connected pixels having the same code (label). In the raster model there is no basic difference in how points, lines and areas are stored.

Through \textit{rasterization} vector data (points, segments or polygons) can be converted to raster formats. Apart from this source of raster maps, there are scanned aerial photographs, satellite images or scanned pictures. Most ILWIS analyses are based on the raster data model. The results of most of the operations are also raster maps.

**Displaying vector and raster maps**

Let us now have a look at the different types of maps in ILWIS. In the previous chapter you have seen the \textit{Landuse} map. Remember that it was a polygon map. Let us now compare the polygon map with a raster map, which is obtained by rasterizing the polygon map.

- Double-click the polygon map \textit{Area-type} in the catalog
- Accept the default values in the Display Options - Polygon Map dialog box by clicking \textit{OK}. The polygon map is displayed.
- Click the title bar of the map window, keep the left mouse button down, and move the map window to the side of the screen. Then release the left mouse button. This is called \textit{dragging}.
- Double-click the raster map \textit{Area-type} in the Catalog. After a while the Display Options - Raster Map dialog box is shown in which you can specify how you want to see the raster map. Note that there are less options than in the Display Options dialog box for a polygon map. Accept the default values in the dialog box by clicking \textit{OK}. The raster map is also displayed in another map window.
- Drag both windows so that they are next to each other.
The first impression is that both maps are the same. They are similar with respect to the information they contain. You can check this by clicking the same unit in both maps. The units of both maps are also displayed in the same colors. The difference, however, is in the way the information is stored in both maps; one in vector format and the other in raster format. You can best evaluate this by zooming in on both maps.

- Click the **Zoom In** button in the button bar of the raster map. Position the mouse pointer in a section of the map near the boundary of several units. Press the left mouse button, hold it down, and drag it to define a small area to zoom in on.
- Repeat this procedure for the polygon map. Zoom in on the same area.

Now you can see quite some difference between the two maps. The polygon map displays smooth boundaries between the units, whereas the raster map has a blocky appearance. If this is not clear then zoom in further. The blocky appearance in the raster map is related to the fact that each pixel in the map belongs to either one of the land use units. You are able to see individual pixels.

- Close the map window that displays the polygon map **Area-type**

- Zoom in on a part of the raster map **avn1geo** you clearly see the different pixels of which this image is composed.

In a satellite image nearly each of the individual pixels has a different value than its neighbors, due to the different reflectance values of the earth surface as recorded by the sensor of the satellite.

- Read some of the pixel values in the map **avn1geo** by clicking individual pixels with the left mouse button.
- Click the **Entire Map** button in the button bar to display the entire map in the map window.

The values that you can read from the map are whole numbers between 0 and 255. This means that whenever we work with satellite images (such as SPOT or Landsat) the domain of these images is called: image. **Domain Image** is used for satellite images, and scanned black and white aerial photographs. Pixel values in a band of a satellite image represent reflection values in a certain wave-length interval.

**Layer management**

Now we will have a look at the other types of vector data: **point maps** and **segment maps**. These maps will be displayed in the same map window. A map window can contain only one raster image, but it can be combined with several segment, polygon or point maps. Each of these maps displayed in a map window is called a **data layer**.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

- Open the Layers menu and select the Add layer command (or just right click).
- Select segment map Drainage from the list box. Click OK. The Display Options - Segment Map dialog box is opened. Select the check box Info. Click OK. The segment map Drainage is now added to the list.

Segment map Drainage is now displayed on top of raster map Tmb1.

- Click the drainage lines to learn the contents of the map Drainage.

Class domain

Class
As you can see the segment map Drainage contains only one unit: Drainage. This is a class. The contents of the segment map Drainage therefore, consists of classes. In ILWIS terms it is said that the segment map Drainage has a Class domain.
A class domain consists of a list of class names and optionally class codes. Elements in a map (points, segments, polygons or pixels), using a certain class domain, are coded by the class names and codes presented in that class domain; elements without a class name are considered undefined. The same class name can be used for several points, segments, polygons or mapping units in one map. As you will remember from the previous exercise, the polygon map Geological units also had a Class domain, consisting of the names of the different geological types. Let us now add another data layer to the map window: a segment map containing digitized contour lines.

- Add Layer and select the map Contours Kathmandu. The Display Options - Segment Map dialog box is opened.
- Select the check box Info. Click OK. The segment map Contours Kathmandu is now added to the map window.
- Click the contour lines displayed, and read their meaning. Note that you can also still read the meaning of the drainage lines, when you click them.

Value domain

Value
The contents of segment map Contours Kathmandu is different from that of the segment map Drainage. The contour lines are all coded according to their elevation. In this case the contents cannot be represented as classes, but as values. The map Contours Kathmandu therefore has the domain Value.
Value maps and value columns use a value domain. Elements in value maps (raster, polygon, segment, or points) or fields in value columns represent measured, calculated, or interpolated values. Values in a value domain are defined by a minimum and maximum value (the value range) and a precision; values smaller than the minimum or larger than the maximum are considered undefined.

Let us now look at a polygon map. We will now look at the polygon map Area_type, which contains the administrative units of Kathmandu.
Introduction to ILWIS 3.1, using data from Kathmandu, Nepal

Add Layer, and select polygon map Area-type. Click OK. The dialog box Display Options - Polygon Map is opened.

Select the check box Info. Click OK.

Polygon map Area-type is now added to the list.

Identifier (ID) domain

You will see that each ward is identified by a number. These numbers, however, do not represent measured, calculated, or interpolated values. Each ward has its own code and information from each individual block can be obtained from a table connected to the map. The polygon map Area-type has an Identifier (ID) domain. Domain Identifier can be used in maps when each element in a map is identified by a unique name, i.e. an identifier (ID); elements without an identifier are considered undefined. Each item occurs only in principle in one place in the map. Attributes can be linked to the unique names, that is to the identifiers. The attribute table uses the same domain as the map. The attribute table contains additional information on the uniquely identified elements.

Domain Identifier is valid in point, segment, and polygon maps, and in rasterized point, segment, and polygon maps. Domain Identifier is advised for detailed maps on large scales such as 1: 500 for cadastral and infrastructural purposes.

Finally, let us have a look at a point map. The point map that will be displayed is showing the location of boreholes in the area.

Add layer and select point map Borehole_1.

Click OK. The dialog box Display Options - Point Map appears.

In the dialog box there is an option to also show the names of the points. Please note that point map Borehole_1 also uses an Identifier domain. The domain of a map is always indicated on the top of a Display Options dialog box.

Select the check box Text. Further, click the button Font: select the Font type: Arial; Font Style: Bold and Size: 10. Click the OK button in the Font dialog box. Select: Text color: Red.

Click the button Symbol. In the next dialog box, select Symbol Type: Simple; Symbol: Square; Size: 10; Fill color: Green; Line width: 1, and color: Red. Click OK in the Symbol dialog box.

Click OK in the Display Options - Points dialog box.

Practice some more with the Layer Management options. Add some other polygon and segment maps, and see which domain those maps have. Practice also to change the order of the layers by dragging a layer up or down in the list. You can also choose not to display a data layer by clearing its check box Show.
Summary: combining vector and raster maps

In this exercise you learnt the following:

- ILWIS uses two types of maps: vector maps and raster maps.
- Vector maps in ILWIS are either point maps, segment maps or polygon maps.
- Raster maps can be obtained either by rasterizing vector maps, or by importing them from other sources.
- ILWIS allows the display of many data layers in the same map window. A map window can display only one raster map, but together with many different point, segment or polygon maps.
- The contents of a map is defined by the domain of the map.
- The same domain can be used by a vector map, a raster map and a table.
- The following domains are possible:
  - **Class domain**: a list of class names
  - **Value domain**: measured, calculated, or interpolated values
  - **Image domain**: reflectance values in a satellite image or scanned airphoto between 0 and 255. This is a special type of value domain.
  - **Identifier (ID) domain**: a unique code for each item in the map.
- Vector and raster maps can be displayed simultaneously in a map window, using the option **Layer Management**.

The way in which various data layers are displayed in a map window (point, segment, and/or polygon maps, and/or a single raster map) can be manipulated via the Layer Management dialog box: you can select the layers to be displayed; the layers from which you want to obtain information. You can change the display options of a layer, and you can add or remove layers.

The Pixel Information Window

ILWIS has a special tool with which you can examine both maps and tables linked to these maps simultaneously: the **pixel information window**. The pixel information window is used to interactively inspect coordinates, class names, IDs or pixel values, in one or more maps and attribute values of map-related tables. The pixel information window shows information at the mouse pointer position in a map window.

Click the Show Pixel Information button in the button bar of the main window.

The pixel information window is opened (figure 2.3). It contains many of the items that we have seen before in the map- and table windows, such as a control-menu box, title bar, status line, menu bar etc. Some special items in this window are:

- **Top left button**: the upper left gray button in the pixel information window can be used to open the Customize PixelInfo dialog box.
- **Information viewer**: where the information of the selected data objects for the actual position of the mouse pointer in a map window is displayed.
Menu bar: the menus of the ILWIS pixel information window are: File, Edit, Options, and Help.

If you want to display information on maps and tables in the pixel information window, you must make sure that the map is displayed in a map window, and the map and the table are actually linked.

We will now display the map Geological units and use the pixel information window to read the information from this map, along with that of the Area-type map.

- Open polygon map Geological units.
- Drag the polygon map Area-type from the Catalog and drop it to the pixel information window.
- Add polygon map Geological units to the pixel information window in the same way.
- Position the mouse pointer on the map Geological units in the map window.
- Move the mouse pointer on the map to display the information continuously.